
NAME FORMATTING 
 
Q. How do I help ensure that ID cards are accepted by DMV and Insurance  
 Company EDI transactions are matched to the IIES database? 
 
A. Determine whether the vehicles are already registered in NYS. Capture all of the  
 current NYS registration names including registration name variations. These  
 registrant names must be captured as insured/additional insured names on a policy. 
 
Q. I printed an ID Card and gave it to the registrant. When they brought the ID  
 Card to the DMV office it was rejected. What am I doing wrong? 
 
A. There are several reasons why an ID Card may be rejected. The wrong type of ID card 

may have been issued. The effective date or VIN may be invalid. The insured name on 
the ID card may not be the same as the current registration name.  The easiest way to 
ensure name compatibility including name formatting is to obtain the NYS registration 
receipt(s).  

 
Here are some error messages related to the encrypted bar code that might cause the 
registrant’s ID Card not to be accepted by DMV: 
 
INVALID ISSUER STATUS: 
 
Possible reasons: Check your PC Date. If the clock on your PC is off by months or years it could 
make the DMV’s database think you issued a card before you obtained your encryption key. You 
might have issued a card while your status was not valid. 
 
SIGNATURE AUTHENTICATION ERROR: 
 
Possible reason: You may have asked the state insurance department for a new key but never 
plugged it in to ALL copies of IDCardGen. Every time you get a new key you MUST enter it into 
the program via: Options|Setup|Key maintenance or the Setup button on the logon screen. 
 
Q. When I print an organizational card, semi-colons appear where I entered  spaces. Is this a 

bug? 
 
A. No.  Semi-colons print between each organization name component because that is  

exactly how DMV stores organizational names on its main frame. Organization names 
with semi-colons are differentiated from individual names with components separated by 
commas.  NYS Title and registration receipt documents print organizational and individual 
names in this same fashion.  Insurance ID cards now print names the same way for 
consistency and to enhance name matching of electronic transactions submitted to DMV. 

 
Q. What do I do if name components of an individual name do not fit in the individual name 

fields provided? 
 
A. You can abbreviate part of a name by removing right-most vowels starting with the  

right-most name component until the name fits. You should also remove any hyphens if 
they are preventing the last name from fitting before removing vowels.  

 
The goal is to achieve name compatibility between the registrant name and the insured 
name that has long been required by NYS law.  Compatibility of names when policies and 
ID cards are being issued will help ensure that electronic insurance transactions 
submitted to DMV by insurers will be matched to an IIES database record.  Matching 
requires compatibility of VIN and at least one other data element.  If direct matching does 
not occur based on VIN and an individual’s NYS driver’s license number or organization’s 



federal tax number, then name is used.  Direct matching requires an exact match on VIN 
and SMI (the first three letters of the name) from an individual name of 
SMITHSON,JOHN,R or VIN and MOH from an organization name of 
MOHAWK;VALLEY;CORP.  If there is a little as one character discrepancy in VIN then 
DMV attempts to find a single VIN with 70% compatibility in the DMV system via an 
electronic process that attempts “exceptions resolution matching” using the insurer 
submitted VIN and 5-3-1 of name, e.g., SMITH-JOH-R from SMITHSON,JOHN,R.  
Accordingly, please do not perform any name editing that would inhibit direct matching or 
exceptions resolution matching. 

 
Q. I have a registrant with two middle names. How do I enter it? 
 
A. You may enter two middle names in the middle name field by separating them with 
 a comma.  
 
Q. Why am I only allowed two 20-character lines to enter an organizational  name? How do 

I make the name fit? 
 
A. DMV stores organizational names in two 20-character lines on its mainframe. The  

IDCardGen software allows the same so no characters are truncated when it is time to 
store the name on the mainframe. When entering organizational names you must 
separate name components with a space.  The software automatically replaces spaces 
with semi-colons when the ID card prints. You may abbreviate the name by removing 
vowels 

 
John Jacob Astor Inc. edit as                         JOHN JACOB ASTOR INC 
American Machinery And Foundry edit as AMERICAN MACHINERYAND FOUNDRY 
 
Do not space or type periods between initials in corporate names. 
 
B.F. Goodrich Inc. edit as                         BF GOODRICH INC 
C.R. & W.J. Sutherland Inc. edit as             CR&WJ SUTHERLAND INC 
Use INC, CO, CORP, DIV where applicable. 
  
If part of the company name includes SAINT, DO NOT abbreviate it. 
  
  
Saint Claire’s Hospital edit as                         SAINT CLAIRES HOSPITAL 
 
Specific locations: 
  
Saint Lawrence Seaway Auth edit as           SAINT LAWRENCE SEAWAY AUTH 
 
 
Q. How do I enter Trusts and Trustees? 
 
A. Name Editing for Trusts (Organization Name). Such ID cards require special  
 editing to meet legal requirements and to fit in the available space. 
 
         Examples: 
 
         (Individual-Michael Motorist) 
 
         MICHAEL MOTORIST/TST 
 
         %MICHAEL MOTRIST/STL (or /TR) 



 
        (Two individuals- Michael and Constance Motorist) 
 
        M&C MOTORIST/TST 
 
        %M&C MOTORIST/STL (or /TR) 
 
        TST= Trust 
 
        STL= Settlor (Grantor or Trustor) 
        TR= Trustee 
 
GENERAL DATA ENTRY 
 
Q. My company’s ICC code in not listed in the ICC code drop down box or my company’s 

name has changed and is not correct in the IDCardGen software. When will there be an 
update to this? 

 
A. Users have the ability to add, delete or change the name of any company. After logon, 

click on the “Options” menu item, and then select “Setup”. The very first tab you see is 
the “ICC Entry” tab.  Enter the 3-digit ICC code and insurance company name, and press 
“Add Issuer”.  Next hit OK and the new or corrected ICC and name entry appears in the 
ICC code dropdown list box under the Insurance tab. 

 
Q. We issue ID Cards under two different agencies from one PC. When I log on and print a 

card it has my name and address in the upper left side of the document. When another 
agent logs in and prints a card it still has my name and address on the upper left of the 
card. How do we allow the printing of multiple agencies? 

 
A. IDCardGen was designed to print cards for a single agency at a single location. No 

matter which Issuer logs in, it will always print the agency name and address that you 
entered the very first time you set up the program. If you wish to change this name and 
address you can select the “Options” menu item, then select “Setup”. Next select the 
“Agency Info” tab and correct the information. If you want to be able to print ID Cards 
using multiple agency names and addresses it is suggested that you install a separate 
copy of IDCardGen on your PC for each agency. Be careful not to choose the same 
location each time you install it or it will just overwrite itself. The destination path may be 
altered by choosing a ‘custom’ install. The alternative to this would be to install the 
software on a different PC with the second issuer name.  

 
  
Q. I’m only given 20 characters for street address. How do I fit longer addresses in to the 

space provided? 
 
A. Abbreviate part of a name by removing right-most vowels until the name fits. 
 
BASIC FORMAT: 
 Number (space), Street Name (space), Street Type.  Spaces count as a character. 
 
BASIC EDIT PROCEDURE: 
  
 Use standard abbreviations when possible (ST, AV, RD, DR, etc). 
  
 
Edit street number to numerals when spelled out alphabetically. If still over 20 characters: 
 



1.  Eliminate unnecessary parts of the street name (if possible). 
2.  Eliminate vowels in STREET NAME from RIGHT to LEFT. 
 
    Apartments 
 
 17 Latham Villages Lane Apt 10 edit as 17 LATHAM VIL LA A10 
  
    Directions 
 

North, South, East, West edit as N, S, E, and W EXCEPT: When the direction is the 
name of the street. West Avenue edit as WEST AV 

 
    Route Number 
  
 All RD, RT and RR addresses must show a road name or number.  
 Always edit RD first, RT second, then the box, then the street or road.  
 If it will not fit, omit street or road. 
  
 Route 89, Box 123 edit as RT 89 BX 123 
  
 RFD 2 Box 245 Sunflow Rd edit as RD 2 BX 245 SUNFLOW 
     

Rural Route 26 edit as RR 26 
 
    Post Office Box 
 
 P.O. Box 555 edit as PO BX 555 
 
    In Care Of 
 
 124 Fifth Avenue c/o John Doe edit as 124 5TH AV %DOE 
 
Q. We have to issue ID Cards for NY Dealer plates. These ID Cards don’t have a year, 

make or VIN. They simply read “Dealer-Garage Auto Liability Policy”. Does IDCardGen 
allow printing of this notation? 

 
A. Yes. There are three 3-digit non-vehicle specific codes related to Dealers and  

Transporters that you can enter in to the Year field the tell IDCardGen which notation to 
print: 

 
    AON  
 
 Prints “All Owned & Non-Owned Vehicles- Comprehensive Auto Liability  Policy”  
 Only acceptable for dealer registration classes 
 Cannot be used with the FS-21 or the FH forms 
             
    DGP 
 Prints “Dealer-Garage Auto Liability Policy” 
 Only acceptable for dealer registration classes 
 Cannot be used with the FS-21 or the FH forms 
 
    ALP  
 Prints “Auto Liability Policy” 
 Only acceptable for the transporter registration class 
 Cannot be used with the FS-21 or the FH forms 
 



Enter one of these codes in the vehicle year field.  No additional entry on the vehicle tab is 
required. 
 
Q. What are these 3-digit codes in the vehicle year drop down box? 
 
A. Those are the special codes used to issue non-vehicle specific ID cards. Please see the 

above answer above for more detail.  
 
 NOTE: the 4th non-vehicle specific code that can be used for fleet ID cards is: 
 
    AOV 
 Prints “All Owned Vehicles” 
 Requires 5 or more motor vehicles registered in NYS (non-for hire) 
 Requires 10 or more for hire (FH) vehicles registered in NYS 
 
 
 
MISCELLANEOUS 
 
Q. Would it be possible to install IDCardGen on a server once, and then have all other PCs 

on the network run the program from that single location? 
 
A. Yes. Here are the instructions: 
 
1.)  Log on to the server that you would like to store IDCardGen on. 
 
2.) Install the program from the setup file that can be downloaded from the NYS Insurance         
Department’s web site http://www.dfs.ny.gov/insurance/iies/html/iies2.htm 
 
3.) An icon should now appear on the desktop. Double click on it, hit setup and enter an agent’s 
issuer ID and key. 
 
4.) Try logging in to the application and make sure everything works  
 
5.) Using windows explorer, navigate to the location that you just installed the program in.  
 
6.) Right click on the InsuranceCardGen.exe file and choose ‘Create Shortcut’. 
 
7.) A new shortcut should now exist. Copy this shortcut to the desktop of every PC that is 
connected to the server that is going to be used to issue ID cards. 
 
  
 
Q. I just installed IDCardGen but I don’t see any new icons or folders. What happened? 
 
A. This will usually happen to PCs running Windows NT. If the person who installed 

IDCardGen is not an ‘Administrator’ of the PC or if the NT security level of the person 
currently logged on is not high enough to allow setup programs to create shortcuts, then 
the following instructions can be used to create the proper icon on the desktop:  

 
1.) Hit the start button and select 'Find' 
 
2.) In the 'Named' edit box type: 'InsuranceCardGen.exe' 
 
3.) Make sure the 'Look in' edit box says its C: or whatever drive the person installed the software 
on 

http://www.ins.state.ny.us/iies/html/iies2.htm
http://www.dfs.ny.gov/insurance/iies/html/iies2.htm


 
4.) InsuranceCardGen.exe should now be in the list of files found. Right click on it and choose 
'Create Shortcut' 
 
5.) It will say "Windows cannot create a shortcut here. Do you want the shortcut to be placed on 
the desktop instead?" 
 
6.) Click "Yes" 
 
7.) The shortcut should now appear on the desk top. 
 
  
 
Q. Do I need special paper to print these new bar-coded ID Cards? 
 
A.     Each IDcard shall consist of at least two identical parts, 5 inches through 8 ½ inches in width 
by 3 inches to 5 ½ inches in height, printed on stock not lighter than 20–pound white bond, and 
shall bear the title “NEW YORK STATE INSURANCE IDENTIFICATION CARD” and the form 
numbers prescribed by this Part. Minimum size: 3” X 5 ”. Maximum size: 5 ½” X 8 ½”. ID cards 
shall be computer issued. Portions of the required information, such as the legally required 
statements, may be pre-printed. ID cards shall contain the compliant encrypted 2D bar code 
security feature produced in full accordance with the specifications prescribed by this Part and 
DMV technical documentation. 
 
Q. If a customer is purchasing a new vehicle and the Dealer is registering the vehicle for the 

customer, can the Dealer use a faxed copy of the new 2D bar-coded ID Card or does the 
DMV require and original 2D card. 

 
A. Yes. If the bar code card is readable (the large “faxable one” on the 8 ½” X 11” sheet 

under the “two-up” printed ID cards) after faxing. The quality of the two fax machines can 
be an issue. E-mailing rather than faxing is recommended.  

 
LOADING/SAVING 
 
Q. Is there a way I can save an ID card so I can pull it back up and change some of the 

information at a later date? 
 
A. Yes. As of version 1.2 you are now able to load and save ID cards. These files will be 

stored XML format, which should make it easy for other programs to read and understand 
the data. You may access these features under the ‘File’ menu. 

 
Q. When I try to load or save a document I keep getting an error that says “Error  

Initializing MS XML Parser. Please make sure you have Microsoft XML Parser 3.0 and 
Microsoft Internet Explorer 4.01 SP1 or greater installed on your PC. You may reinstall 
IDCardGen and answer YES to the installation of this tool.” What does this mean? 

 
A. This error means IDCardGen was unable to start the XML parser. This utility comes with 

the IDCardGen installation file. If reinstalling IDCardGen doesn’t make this error message 
go away you should download and install the very latest Microsoft Internet Explorer 
browser as it is an essential component for the XML parser to work properly. 

 
Q. What is this batch processing feature? 
 
 
A. The batch process feature is mainly meant for advanced users who wish to export their 

policy data from their agency management systems or mainframe and package and 



import and process it using the IDCardGen software. Please see the Batch Processing 
section in the help file for more information on how to use this feature. 
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